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Important note
The present protocols are research protocols, based on laboratory 
experience. Miltenyi Biotec cannot and will not accept any liability 
as to the outcome of procedures. The procedures are for research 
use only, not for clinical use.

1.	 Description
1.1	 Background

The CliniMACS Prodigy enables the automated production of 
chimeric antigen receptor (CAR) T cells. During the process, cell 
samples are collected and monitored by flow cytometry for quantity 
and composition of immune cell populations and presence of 
CAR T cells. The MACSQuant® Analyzer 10, MACSQuant X, and 
MACSQuant Analyzer 16 in conjunction with the CAR T Cell 
Express Mode Package can be used for automated analysis of 
immune cell composition and for detection of CAR T cells at all 
stages required during the CAR T cell manufacturing process. The 
number and frequencies of cell populations can be determined 
from the flow cytometric statistics generated at the end of the 
CAR T Cell Express Mode analysis. This protocol describes the 
preparation  of samples, setup of the instrument, and analysis of 
data using the CAR T Cell Express Mode Package.

1.2	 Reagent and instrument requirements

●	 MACSQuant Analyzer 10 (# 130-096-343), MACSQuant X 
(# 130-105-100), or MACSQuant Analyzer 16 (# 130-109-
803) installed with a compatible MACSQuantify™ Software 
version:

	 For MACSQuant Analyzer 10: The CAR T Cell Express Mode 
Package (# 160-002-376) compatible with MACSQuantify 
Software version 2.11.5 and higher. 

	 For MACSQuant X: The CAR T cell Express Mode Package 
(# 160-002-376) is only compatible with MACSQuantify 
Software versions 2.11.5, 2.13.0, and 2.13.2. MACSQuant X is 
not compatible with software versions 2.13.1 and 2.13.3.

	 For MACSQuant Analyzer 16: The CAR T Cell Express Mode 
Package (# 160-002-376) is compatible with MACSQuantify 
Software version 2.13.3.

 ▲ Note: It is recommended to verify the compatibility of the MACSQuantify 
Software and the respective CAR T Cell Express Mode Package. 

●	 MACS® MiniSampler Plus (# 130-105-745) and Chill 5 Rack  
(# 130-092-951).

 ▲ Note: The MACS MiniSampler Plus in combination with the Chill 5 Rack 
will be necessary if not using the Single Tube Rack.

●	 Refrigerator.

●	 Centrifuge suitable for 12×75 mm tubes with cap.

●	 Vortex mixer.

●	 Micropipettes with disposable tips.

●	 50 mL conical tubes.

●	 PBS/EDTA buffer, e.g., autoMACS® Rinsing Solution  
(# 130‑091‑222).

●	 BSA, e.g., MACS BSA Stock Solution (# 130-091-376).

●	 Red Blood Cell Lysis Solution (10×) (# 130-094-183).
 ▲ Note: Red blood cell lysis should only be necessary for the analysis of 

starting material.

●	 Double-distilled water (ddH2O).

●	 Inside Fix, a component of the Inside Stain Kit (# 130-090-477).
 ▲ Note: Fixation is mandatory for samples to be handled under specific 

laboratory safety requirements. Please follow local regulations.

●	 Antibodies and reagents as listed below in tables 1 and 2.

Product Order no.

StainExpress Immune Cell Composition Cocktail, 
human 130-127-637

StainExpress CAR T Transduction Cocktail, human 130-127-638

Table 1: StainExpress Cocktails required for flow cytometric analysis of 
immune cell composition and CAR T transduction (CAR T T) efficiency. 
For each of these reagents use the volume, incubation time, and dilution 
indicated in the respective data sheet.

Determination of immune cell 
composition and CAR T cells from 
a CliniMACS Prodigy® CAR T Cell 
manufacturing process
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Product Order no.

CD19 CAR FMC63 Idiotype Antibody, PE, REAfinity™ 130-127-342

CD19 CAR FMC63 Idiotype Antibody, Biotin, REAfinity* 130-127-345

CD22 CAR Detection Reagent, human, Biotin* 130-126-727

BCMA CAR Detection Reagent, human, Biotin* 130-126-090

CD19 CAR Detection Reagent, human, Biotin* 130-129-550

CD33 CAR Detection Reagent, human, Biotin* 130-127-642

Table 2: Recommendation of antibodies and CAR Detection Reagents 
to be added to the StainExpress CAR T Transduction Cocktail. Choose 
one of the above-mentioned CAR Detection Reagents or refer to  
www.miltenyibiotec.com for additional CAR Detection Reagent options. 
For each of these reagents use the volume, incubation time, and dilution 
indicated in the respective data sheet.

*Use Biotin Antibody, PE, REAfinity (# 130-110-951) in combination 
with these reagents.

1.3	 Preparation of solutions

▲ Solutions should be prepared freshly. Discard unused solutions 
at the end of the day.

●	 1× Red Blood Cell Lysis Solution
	 Prepare 2 mL of 1× Red Blood Cell Lysis Solution by diluting 

Red Blood Cell Lysis Solution (10×) 1:10 with ddH2O, e.g., 
dilute 200 µL Red Blood Cell Lysis Solution (10×) with  
1.8 mL of ddH2O and mix well. Adjust for multiple samples 
accordingly. Store and use at room temperature (19−25 °C). 

●	 Buffer: Prepare PBS/EDTA buffer supplemented with 0.5% 
BSA by diluting MACS® BSA Stock Solution 1:20 with, e.g., 
autoMACS Rinsing Solution. Store at 2−8 °C. 

1.4	 Compensation

▲ For optimal compensation refer to the data sheets of the 
StainExpress Immune Cell Composition Cocktail, human (# 130-
127-637) and the StainExpress CAR T Transduction Cocktail, 
human (# 130-127-638).

 ▲ Note: For optimal compensation always use the provided StainExpress 
Compensation Set matching the StainExpress Cocktails used. To ensure they 
match, check for identical order number-related lot numbers indicated on the 
pouches next to the expiration date.

2.	 Staining protocol
2.1	 Sample preparation

1.	 Collect the respective samples for the analysis of immune 
cell composition (ICC) and CAR T transduction (CAR T T) 
efficiency as described in table 3. If desired, an additional 
in-process control (IPC) can be performed between day 9 and 
day 11. CliniMACS Prodigy Process Samples are obtained 
using the sampling adapter. A minimum of 100 µL sample 
volume with a maximal concentration of 1×10⁷ cells/mL is 
required for each analysis.

 ▲ Note: If the concentration is higher, dilute the cell suspension with buffer 
and keep the respective dilution factor in mind. It will be needed for cell count 
calculations at the end of the analysis.

Sampling date Sample type Analysis

Day 0 Starting material and enriched 
T cells ICC

Day 5 CliniMACS Prodigy sample ICC, CAR T T

Day 9-11 (optional) CliniMACS Prodigy sample ICC, CAR T T

Day 12 CliniMACS Prodigy sample and 
final cell product

ICC, CAR T T

Table 3: Exemplary sampling date, sample type, and recommended 
analysis.

2.	 Label the required number of tubes with the panel (ICC or 
CAR T T) and a suitable sample ID.

2.2	 Labeling of cells with StainExpress Cocktails

2.2.1 Staining protocol for immune cell composition

▲ To avoid loss of cells and changes in cell composition, the ICC 
panel should be applied as a ‘no-wash protocol’.

1.	 Add 100 μL of cell suspension to one tube of StainExpress 
Immune Cell Composition Cocktail, human. 

2.	 Incubate for 10−20 seconds, then vortex at high speed for 5 
seconds and incubate for 10 minutes in the dark at 19−25 °C.

 ▲ Note: Working at lower temperatures requires increased incubation times. 

3.	 If the sample does not require red blood cell lysis or fixation, 
add 1900 µL of buffer for analysis by flow cytometry. 

	 or

	 If the sample does require red blood cell lysis but no fixation, 
add 1900 μL of 1× Red Blood Cell Lysis Solution and 
immediately vortex thoroughly for 3 seconds. Incubate for 15 
minutes in the dark at 19−25 °C.

	 or

	 If the sample requires fixation, follow the user instruction of 
an appropriate fixative reagent, e.g. Inside Fix, a component 
of the Inside Stain Kit. In case Inside Fix is used, it is 
recommended to adjust the sample volume to 250 µL by 
adding 150 µL of buffer prior to adding 250 µL of Inside Fix. 
Mix well and incubate for 20 min at room temperature in the 
dark. Add 1500 µL of buffer for analysis.

 ▲ 	Note: Fixation is mandatory for samples to be handled under specific 
laboratory safety regulations. Please follow local regulations.

 ▲ 	Note: Do not wash the sample after fixation. Adjust the volume to 2 mL 
using buffer.

4.	 Store the samples at 2−8 °C protected from light until 
acquisition on the MACSQuant Analyzer. Acquire samples 
within one hour after staining.
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2.2.2 Staining protocol for CAR T transduction efficiency

1.	 Add 100 μL of cell suspension to one tube of StainExpress 
CAR T Transduction Cocktail, human. 

2.	 Add suitable amount of CAR Detection Reagent. Refer to the 
respective data sheet for more information.

3.	 Incubate for 10−20 seconds, then vortex at high speed for 5 
seconds and incubate for 10 minutes in the dark at 19−25 °C. 

 ▲ Note: Working at lower temperatures requires increased incubation times. 

4.	 Wash cells by adding 1 mL of buffer and centrifuge at 300×g 
for 5 minutes. Aspirate supernatant completely. 

5.	 (Optional) If using a biotin-conjugated CAR Detection 
Reagent, follow steps 5 a−c: 

	 a. Resuspend cells in 98 μL of buffer and add 2 μL of Biotin 
Antibody, PE, REAfinity. 

	 b. Vortex shortly at high speed and incubate for 10 minutes in 
the dark at 19−25 °C. 

	 c. Wash cells by adding 1 mL of buffer and centrifuge at 300×g 
for 5 minutes. Aspirate supernatant completely. 

6.	 If the sample does not require fixation, resuspend cell pellet in 
2 mL of buffer for analysis by flow cytometry. 

 ▲ Note: It is recommended to resuspend the cells in a smaller volume first (e.g. 
200 μL) and then to fill up to 2 mL.

	 or

	 If the sample requires fixation, follow the user instruction of 
an appropriate fixative reagent, e.g., Inside Fix, a component of 
the Inside Stain Kit. In case Inside Fix is used, it is suggested to 
adjust the sample volume to 250 µL with buffer prior to adding 
250 µL of Inside Fix. Mix well and incubate for 20 min at room 
temperature in the dark. Add 1500 µL of buffer for analysis.

7.	 Store samples at 2–8 °C protected from light until analysis. 
Acquire samples within one hour after staining. 

3.	 Example of a flow cytometric data acquisition 
and analysis using Express Modes

3.1	 Data acquisition using Express Modes

The MACSQuant Analyzers in conjunction with the respective 
CAR T Cell Express Mode Package provide predefined experiment 
settings for automated acquisition and analysis. For accurate 
data acquisition, ensure that the instrument has been set up 
appropriately by performing PMT calibration and compensation by 
measurement of the respective compensation controls. After setup, 
do not change any instrument settings during acquisition of one 
experiment series. A detailed protocol for the usage of the Express 
Modes Immune_Cell_Composition_h_02 or CART_Immune_
Composition_h_03 and CAR_T_Cell_Transduction_h_02 or 
CART_Transduction_h_03 is described in the following section. 
The protocol can be adapted for manual experiment setup and data 
analysis accordingly.

1.	 Click on the Open icon to select and open the current valid 
instrument settings.

2.	 Go to the Channels tab and click on the Advanced button to 
verify that Height is switched on.

3.	 Go to the Experiment tab.
	 ▲ Note: For manual setup of the experiment, refer to the figure below, select 

the respective settings, and annotate the channels by hand.

	 a. Depending on the sample number, select the Single Tube 
Rack or the Chill 5 Rack from the Rack drop-down menu.

	 b. If the Chill 5 Rack is used, select the appropriate number 
of sample positions (indicated by closed green circles) and 
verify that all samples are selected for editing (indicated by the 
orange rim). For colorblind users, the settings can be adjusted 
to closed grey circles and orange rims.

	 c. Select the respective Express Mode:	   
(Immune_Cell_Composition_h_02 or CART_Immune_
Composition_h_03 or CAR_T_Cell_Transduction_h_02 
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or CART_Transduction_h_03, respectively) from the drop-
down list within the Settings tab. All pre-defined experiment 
settings (flow rate, annotations, sample, and uptake volume) 
are loaded automatically, except for the sample mixing which 
has to be selected manually.

	 d. Select an appropriate sample mixing (e.g. Mix medium).
 ▲ Note: If no sample mixing is chosen, the cells might sediment before sample 

uptake. Sedimentation will influence the results. 

	 e. Click on a single well and enter relevant sample information 
in the Sample ID and Description field. Proceed with the 
next well and continue for all wells to be measured.

4.	 Go to View → Experiment table to verify that annotations and 
settings for all samples have been entered correctly.

5.	 Mix your samples by vortexing and place them in the 
respective position in the Chill 5 Rack. Further check for 
sufficient amount of buffers and ensure that the waste bottle 
is empty.

 ▲ Note: Although sample mixing has been selected on the MACSQuant 
Analyzer 10, MACSQuant X or MACSQuant Analyzer 16, it is recommended 
to vortex samples if multiple samples will be measured. 

6.	 Start the acquisition.

3.2	 Data analysis using Express Modes

▲ If the Single Tube Rack is used, the analysis is automatically 
performed directly after acquisition. If the Chill 5 Rack is 
used, the analysis is immediately replaced by the subsequent 
sample for acquisition and can be done afterwards. However, it 
is recommended to use a separate PC (equipped with the same 
MACSQuantify Software version and CAR T Cell Express Mode 
Package) for data analysis and backing up the data files, since 
export of data to Microsoft Excel is only possible when analysis is 
performed on a separate PC. If data analysis has to be performed 
on the MACSQuant Analyzer itself, analysis should be started after 
finishing acquisition.

1.	 After acquisition, data can be copied to the analysis PC. Go to 
File → Copy and select the respective data files and directory 
for copying.
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2.	 On the analysis PC, right click within the Samples tab and 
select Add... to upload data files to the MACSQuantify 
Software.

3.	 Right click on the first data file and select View with Analysis.
Immune_Cell_Composition_h_ 02 or View with Analysis. 
CART_Immune_Composition_h_03 or View with Analysis.
CAR_T_Cell_Transduction_h_02 or View with Analysis. 
CART_Transduction_h_03, respectively, for accessing the 
Express Mode analysis.

4.	 The appropriate analysis pages will be displayed after analysis 
has been finished (see figure 3 and figure 4). During this step, 
the gates are created and individually adjusted to the selected 
sample.

 ▲ Note: Please be aware that depending on the Express Mode version it might 
be necessary to enter the total dilution factor (refer to section 4) of the sample 
and to choose the display unit of the cell concentration (cells/mL vs. cells/µL). 

5.	 If necessary, adjust the gates manually by moving the Gate 
verification window to the side before selecting Export 
results. Do not close this window or select Export results 
before adjusting the gates.

 ▲ Note: Export of data can only be done once within the automated Express 
Mode analysis. Make sure all regions are set properly before exporting the 
data. If adjustments are necessary after the results have been exported, start 
the analysis again and perform manual adjustments to the gates before 
selecting Export results. The Gate verification window must be closed before 
commencing a new Express Mode analysis. When the analysis is performed 
on the MACSQuant Analyzer itself, the Gate verification window is not shown 
and therefore data export cannot be performed.

6.	 By selecting Export results, the Express Mode software 
version, the file name, sample ID, description, and statistics 
are exported to an Excel file (‘data file name_results’) and 
saved in the same directory as the data file.

7.	 To print the analysis, go to File → Print.
8.	 Accomplish the analysis, gate adjustment, and export of 

results for the remaining data files.
 ▲ Note: For manual analysis, refer to the gating hierarchies and plots in figures 

1–4 and perform the gating and export of results by hand.

Figure 1: Hierarchical gating strategy for the ICC analysis. Subtypes of 
T cells (CD4 and/or CD8), as well as NKT cells, monocytes, neutrophils, 
eosinophils, and B cells can be determined based on the marker expression 
indicated in brackets.
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9.	 As shown in figure 1 and figure 3, subtypes of T cells (CD4 
and/or CD8), NKT cells, monocytes, neutrophils, eosinophils, 
NK cells, and B cells can be determined with the antibodies 
included in the ICC panel.

 ▲ Note: Keep in mind that populations other than T cells might be absent 
when analyzing the enriched T cell sample of the CliniMACS Prodigy Process 
Samples.

Figure 2: Hierarchical gating strategy for the CAR T transduction 
efficiency analysis. CAR+ and CAR– T cells can be determined and further 
subdivided for their expression of CD4 and/or CD8. Monocytes that might 
be partially enriched during T cell enrichment should be excluded via 
CD14 staining.

10.	 CliniMACS Prodigy Process Samples are stained with the 
respective antibodies for the CAR T T panel to detect CAR+ 
and CAR– T cells, and to analyze these for CD4/CD8 subtypes 
(see figure 2 and figure 4).

 ▲ Note: Due to a possible CD4dim expression, it cannot be excluded that 
monocytes are partially enriched during CD4/CD8 T cell enrichment. To 
exclude presence of monocytes during the CliniMACS Prodigy Process, 
staining for CD14 in the CAR T T panel is mandatory (see figure 4).

Figure 3: Gating strategy and populations that can be determined 
by using the Immune_Cell_Composition_h_02 or CART_Immune_
Composition_h_03 Express Mode. Data from a healthy donor 
leukapheresis sample at day 0 of the CliniMACS Prodigy T Cell 

manufacturing process is depicted. After debris exclusion (A) and gating 
for CD45+ cells (leukocytes, B), the viable cells are detected by exclusion 
of 7-AAD (C). Subsequently, cells can be divided in CD3+ cells and CD3– 
cells (D). Based on CD56/CD16 expression, CD3+ T cells can further be 
divided into NKT cells (CD56/CD16+) and conventional T cells (E); these 
conventional T cells can be distinguished by their expression of CD4 and/
or CD8 (F). CD3– cells comprise B cells (CD19+ CD14–), monocytes (CD14+ 
CD19–), NK cells (CD14– CD19– CD56/CD16+ SSClo), eosinophils (CD14– 
CD19– CD56/CD16– SSChi), and neutrophils (CD14– CD19– CD56/CD16+ 
SSChi) respectively (G, H). Keep in mind that data will look different in 
terms of cell composition when analyzing CliniMACS Prodigy Process 
Samples. 

Figure 4: Gating strategy and populations that can be determined by using 
the CAR_T_Cell_Transduction_h_02 or CART_Transduction_h_03 
Express Mode. Data from an IPC sample at day 12 of the CliniMACS 
Prodigy T cell manufacturing process is depicted. After debris exclusion 
(A) and gating for CD45+ cells (leukocytes, B), the viable cells were 
detected by exclusion of 7-AAD (C). Subsequently, cells were divided into 
CD3+ and CD3– cells (D). With CD19 CAR Detection Reagent, CD3+ cells 
were further divided into CAR+ and CAR– cells (E). Both subpopulations 
(CAR+ cells, F; CAR– cells, G) can be distinguished by their expression of 
CD4 and/or CD8. Additionally, CD14 expression should be determined to 
exclude the presence of monocytes (CD3– CD14+, H).
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4.	 Analysis of results
Calculation of dilution factor

As the sample is diluted during sample preparation, the total 
dilution factor needs to be calculated. For this purpose, the pre-
dilution factor, the total staining volume (e.g. 2 mL), and the sample 
volume (e.g. 100 µL) have to be considered. This is only applicable 
if the sample had to be adjusted for an appropriate concentration 
before staining. If no pre-dilution has been performed, the pre-
dilution factor is “1”.

Total dilution factor =

Pre-dilution factor ×
Total staining volume

Sample volume

Calculation of cell concentration
The final cell concentration (exemplary for CD3+ cells) is calculated 
using the MACSQuant Analysis Report (ICC analysis) and the 
dilution factor.

Final cell concentration CD3+ cells (cells/µL) =

Cell concentration CD3+ cells (cells/µL) × Total dilution factor

To determine the final cell concentration of CD3+ cells per mL 
(cells/mL), multiply the final cell concentration of CD3+ cells (cells/
µL) by 1,000.

Final cell concentration CD3+ cells (cells/mL) =

Cell concentration CD3+ cells (cells/µL) × 1,000

 ▲ Note: If a dilution factor was entered during the Express Mode analysis and 
the unit of cell concentration cells/mL was selected, the section “Calculation 
of cell concentration” can be neglected and it can directly be proceeded with 

“Calculation of CD3+ cell count”.

Calculation of CD3+ cell count
To determine the total amount of CD3+ cells (e.g. in the entire 
leukapheresis product), use the calculated final CD3+ cell 
concentration and multiply by the total volume of cell suspension.

Total CD3+ cell count =

Final cell concentration  
CD3+ cells (cells/mL) × Total volume of  

cell suspension (mL)

Calculation of CAR+ cell concentration
To determine the CAR+ cell concentration, use the final CD3+ 
cell concentration (cells/mL, ICC analysis) and multiply by 
the observed frequency of CAR+ cells among viable CD3+ cells 
(CAR T T analysis). For the total CAR+ cell count, multiply this 
concentration by the total volume of the suspension (inside the 
CliniMACS Prodigy system).

CAR+ CD3+ cell concentration (cells/mL) =

Final cell concentration  
CD3+ cells (cells/mL) (ICC) ×

% CAR+ among viable CD3+

100

Total CAR+ cell count =

CAR+ CD3+ cell  
concentration (cells/mL)  × Total volume of  

cell suspension (mL)

Refer to www.miltenyibiotec.com for all data sheets and protocols. 
Miltenyi Biotec provides technical support worldwide. Visit  
www.miltenyibiotec.com for local Miltenyi Biotec Technical 
Support contact information.

The CliniMACS System components, including Reagents, Tubing Sets, Instruments, 
and PBS/EDTA Buffer, are designed, manufactured and tested under a quality system 
certified to ISO 13485.
In the EU, the CliniMACS System components are available as CE-marked medical 
devices for their respective intended use, unless otherwise stated. The CliniMACS 
Reagents and Biotin Conjugates are intended for in vitro use only and are not 
designated for therapeutic use or direct infusion into patients. The CliniMACS 
Reagents in combination with the CliniMACS System are intended to separate human 
cells. Miltenyi Biotec as the manufacturer of the CliniMACS System does not give 
any recommendations regarding the use of separated cells for therapeutic purposes 
and does not make any claims regarding a clinical benefit. For the manufacturing 
and use of target cells in humans, the national legislation and regulations - e.g. for the 
EU the Directive 2004/23/EC (“human tissues and cells”), or the Directive 2002/98/
EC (“human blood and blood components”) - must be followed. Thus, any clinical 
application of the target cells is exclusively within the responsibility of the user of a 
CliniMACS System.
In the US, the CliniMACS CD34 Reagent System, including the CliniMACS Plus 
Instrument, CliniMACS CD34 Reagent, CliniMACS Tubing Sets TS and LS, and 
the CliniMACS PBS/EDTA Buffer, is FDA approved as a Humanitarian Use Device 
(HUD), authorized by U.S. Federal law for use in the treatment of patients with acute 
myeloid leukemia (AML) in first complete remission. The effectiveness of the device 
for this indication has not been demonstrated. Other products of the CliniMACS 
Product Line are available for use only under an approved Investigational New Drug 
(IND) application, Investigational Device Exemption (IDE) or FDA approval. 

CliniMACS, CliniMACS Prodigy, MACS, MACSQuant, MACSQuantify, the 
Miltenyi Biotec logo, REAfinity, StainExpress, and Vio are registered trademarks or 
trademarks of Miltenyi Biotec and/or its affiliates in various countries worldwide. All 
other trademarks mentioned in this publication are the property of their respective 
owners and are used for identification purposes only.
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